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1. Installing MetaTrader 4

Once you have downloaded the MT4 executable program and saved this to your desktop, installation is fast and simple.

1. Double-click the MetaTrader exe file to install. This follows the same method for installing any Windows program.

2. Click the Next button after reading the notification message.

-

8, FXCC - MetaTrader 4 Setup (32 bit)

EXCC

0

METAQUCTES SOFTWARE CORP, A
End-User License Agreement
for Trading Terminal

Please read the terms and conditions of this End User License Agreement (collectively,
“Agreement”) carefully before continuing with the product installation. In this Agreement,
unless the content otherwise requires the capitalized terms used herein shall be defined
as set forth in paragraph 1 of this Agreement.

This Agreement is applicable to both, physical persons and legal entities induding
autharized users representing the employer, its employees or other persons using or
accessing the Product on behalf of the Business.

This Agreement, as well as any updates hereof, constitutes a legal agreement between
You and MetaQuotes Software Corp. and govern the use of the Product on any computer
where it shall be installed, either by You or any third parties, MetaQuotes Software Corp.

By dlicking Mext button you agree to the terms of this license agreement.

— Central Clearing Ltd.

Privacy and Data Protection Policy | Settings I Next > | | Cancel |

3. You now need to click the box marked “Yes, | agree with all the terms of this license agreement”. Once that has been
clicked, you can then proceed by clicking the Next button.

4. Selectthe correct installation folder on your computer, the click the Next button:

¥ FXCC- MetaTrader 4 Setup (32 bit)

EXCC

Select the destination folder where you want to install FXCC - MetaTrader 4. To install to a
different location, dick Browse, and select another folder.

Installation folder: | SRRl iNa =R belak

Select the Start Menu group in which you would like Setup to create the shortouts.,

Program group: | FXCC - MetaTrader 4

[+] Open MQL5. community website

— Central Clearing Lid,

< Back Mext = Cancel

5. Asthe program is being installed on your computer, the installation progress bar will fill.
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§: FXCC- MetaTrader 4 Setup (32 bit)

EXCC

| SoupforTadng Sevies

6. Then press Finish button.

7. You will receive the server and login details in an email when your account is created. Select the appropriate server
and click Login server.

FXCC - MetaTrader 4

:'l‘ Authorization allows to get access to the trade account

Login: | 60577 P |

Password: | T |

Server: | FXCC-Demo e

[+] save account information

[ toon || cancel
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2. Using MetaTrader 4

The opening screen of your FXCC MetaTrader 4 platform will look like the image below.

(7= FXCC - MetaTrader 4 - EURUSD,H4 - 5
File View Inset Charts Tools Window Help
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Main menu (access to the program menu and settings)

Toolbars (quick access to the program features and settings)

“Market Watch” window (real-time quotes for the specified instruments)
“Navigator” window (quick access to all your accounts, indicators, expert advisors)
“Chart” window

“Terminal” window (quick access to the trading and account history, list of open positions and placed orders, client
terminal log-file and internal mailbox

3. Customizable Toolbar

You can visualize several different sections here; each will provide you with different functionality. These are separated by
vertical line. Toolbars are fully customizable. Simply Right click on the toolbar you wish to customize and add, or remove
functions you are frequently using, or not using in order to suit your trading preferences.

b~ - & |Gy [GY @New(]rder &3 G5 AutoTrading

4. The Market Watch window

Market Watch can be activated through a variety of routes:

® (CTRL+M key combination

® View > Market Watch menu sequence
® The button from the “Standard” toolbar
3 | Cetnral Clearing LTD
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Right click the mouse button on the “Market Watch” window to open the context menu:

 560577: PCC1-Demo - Demo Accourt N |

File View Inset Charts Tools Window Help

B G- |[B] 4 [Gr [ | B NewOrder & @ AutoTrading | 1

‘R - ‘ | — /@ A T % MoMs M5 Mmoo ML e
Varket Watch; 15:3%:11 x
Symbol Bid Ak~
& USDCHF 0.99287 0.99296 | _
& GBPUSD 131458 131468 |
N, o R
o USDIPY B3 Chart Window 113.203
9 USDCAD 129651
& AUDUSD [ Tick Chart Space 0.70916
& EURGER Depth Of Market  Alt+B 087419
& EURAUD [8] Specification 162060
o EURCHF, ) 134108 7
Symbols | Tick Chart | Hide Delete
Javigator Hide All =
5-[#) Indicators Show All o
B ) Tnd Symbols cl-u it
@ F| Oscillators
- [F] Volumes sets 3
@ [F] Bill Williams Spresd
@) Eamples m
L) Accelerator HighLew
1[5 Accumulation Time
5 Alligater v Auto Amange
@ ATR v Gid
i[5 Awesome -
Common | Favorites | B Popup Prices F10

Chart Window - opens the chart of a currency pair

Tick Chart - displays the tick chart for the selected instrument

positions or charts, corresponding symbols will not be removed)
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Time - displays the latest quote for each instrument

Show All - displays all available symbols in the “Market Watch” window
Symbols - opens a window to hide/show the selected instruments;

Grid - hides/displays gridlines in the “Market Watch” window

New Order - opens a dialog window to open/close a position or to place a new trade

Hide - removes the selected symbol from the list in the “Market Watch” window

Sets - saves/adjusts/deletes any custom settings for the “Market Watch” window
High/Low - shows/hides columns with the highest and lowest prices for each instrument

FXCC MetaTrader 4 User Guide

Hide All - removes all symbols from the list in the “Market Watch” window which are not in use (if you have open

Popup Prices - opens a popup window which contains real time quotes for your selected instrument
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5. Charts

In MetaTrader 4, you can view as many charts as you wish on one screen. These charts can be for any instrument and any
time period. MetaTrader 4 includes the following chart types:

Line Chart. Horizontal axis displays the various time periods, vertical axis displays the prices.

Bar Chart. Each bar on the chart displays a high price (top), a low price (bottom), an opening price (horizontal line left) and a
closing price (horizontal line right) over the selected time period.

| CEEUSD . 1.00040 100007 LT 1.75040
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Candlesticks. These charts are formatted the same way as Bar Charts and display the same information. High, Low, opening
and closing prices over the selected time period.

In MetaTrader 4 Bar and Candle charts follow the same nomenclature:

High Point is the highest Bid price for selected time period
Low Point is the lowest Bid price for the selected time period
Opening Price is the first quoted Bid for the time period

Closing Price is the last quoted Bid for the time period

In order to create a new chart for any instrument right click on the “Market Watch” window, then select the Chart window
item from the context menu:

%= 300032: FXCC - MetaTrader 4 - Demo Account - [EUJ

- File View Inset Charts Tools Window Help

B B [[m @ Gn [ L | G NewOrder
Hk |1 — / # E A H %l
| Symbol Bid Ask | ~

< USDCHF 0.31119 0.91125
9 GBPUSD 1.60703
+ EURUSD

1.60708

New Order

@ USDJPY S
4 USDCAD [igh Chart Window
{ & AUDUSD el Tick Chart Space
4 EURGBP 84041
| EURAUD Hide Delete (41369
| & EURCHF Hide Al 23073 x|
| Symbols | Tick ch Show All
[ Navigator Symbols ud
| Force | Sets > ':J
Fractall
£ Gator High/Low
| lchimol T
71 MACD i
Markel ¥ Auto Arrange
Momer| v Gnd
£ Money|
7 Movind BB Popup Prices F10

Maoving Average of Oscillator

: Common Favorites |

x 4 I T30 |
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Currency pairs can be added onto vacant chart windows simply by dragging and dropping.

Chart period - the period of time corresponding to each bar or candle. Creating a 5 minute Bar Chart for example will display
bars with price information over a 5 minute period.

MetaTrader 4 supports the following time periods:
M1 - 1 minute
M5 - 5 minutes

M15 - 15 minutes

|
M30 - 30 minutes FL S MIS B30 P HL S H4 D1 Wl BN

H1 -1 hour
H4 - 4 hours
D1- 1 Day
W1 - 1 Week

MN - 1 Month

Right click anywhere on the chart to bring up the context menu to get access to the chart settings:

: Buy Limit 1.00
W |‘|| ||| |I Im |‘||||‘|\|I ”|I||\I|| \|||“” |||‘ |

Sell Limit 1.00 111653

|| i |
Trading ||| | ||| hl M
Depth Of Market Alt+B

One Click Trading  Alt+T

11163

Trading
| | || || | | Depth Of Market Alt+B
‘ ||"' ( ||| | ||| One Click Trading
||||||I |||'I|| |I | Indicators List

Indicators List Crl+1 1 Minute Timeframes

Timeframes 5 Minutes Template

Template af! I mis 15 Minutes i Refresh

Refresh o B 30 Minutes Auto Arrange Ctrl+4
i, sy 1”1{ ”'1‘1 1, II ] zufto Arrange Ctrl+A | HL 1 Hour Grid Ctrl+G

rid Ctrl+G H4 4 Hours L. Volumes Cirlel

Volumes Ctrl+L o o1 Daily

Zoomn . ) Wi Weekly @&, ZoomIn *

Zoom Out - I Maonthly Q Zoom Out

=

Save As Picture... \ [ Save As Picture...

Print Preview
li.

Print Preview

i &

T Print... Ctrl+P

Properties.

. Properties...

Choose Periodicity and select a time period from the drop down

Select Refresh item if an error occurs. Any missing data will be accessed from the server and will appear on the chart.
Select Grid if you wish to hide/unhide gridlines on the chart.

Select Volumes in order to show/hide tick volume.

Zoom in / Zoom out will help you to modify chart measures.

Save as picture will save the chart as a gif or bmp image file.
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Properties (or the F8 button) allows you to personalize your chart settings. The “Color” tab displays all the options for chart
color settings.

Colors | Common

Color scheme: - Background: [l Black

Foreground: White
Grid: [ LightSlateGray

Bar Up: Lime

Bar Down: Lime
Bull candle: [l Black
Bear candle: White

Line graph: Lime

Volumes: LimeGreen
Ask line: [l Red
Stop levels: [l Red

OK ]| Cancel || Resst

CCI{19) -3.2634

Other settings can be changed in the “Common” tab of the Properties dialog.

Properties of USDCHF M

Colors | Common

Offline chart @) Bar chart
Chart on foreground Candlesticks
Chart shift Line chart

| Chart autoscroll
| Show OHLC

Show Ask line

Scale fix One to One i
Show period separators

Scale fix | Show grid
[ Show volumes

Show object descriptions

OK ]| Cancel || Reset

Other available options:
Offline chart - the chart is not being automatically updated.
Chart shift - used for moving the current chart inside the chart window.

Chart auto-scroll - scrolls the current chart to the left of the chart window as new quotes arrive in the system.
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6. Indicators

FXCC MetaTrader 4 User Guide

In the indicators section you can select your desired indicator and apply it to a chart. These tools are used in technical analysis

and you would need to find one that suits your style.

When you select a specific indicator you can adjust the parameters a

ccording to your preferences. This option won't be

presented automatically you can change these settings under Option of a chart.

E4 660577: FXCC1-Dema - Demo Account - [EURUSDHA] T

. -
T e -

B T

) File View |Inset | Charts Tools Window Help
(G h~ 3| Indicators o Accelerator Oscillator ® & || Ik @, 0-=x-
I [ [ | L Accumulation/Distribution

e nes »

Market Watch: 15:3 pr— . Alligator e

Symbol Gann N Average Directional Movement Index

& USDCHF Fibonacci R Average True Range 9 1 1 9 1 6

4 GBPUSD ch N Awesome Oscillator L14 ; I
[ EURUSD | e

& USDIPY Arrows v Trend * Average Directional Movement Index
& USDCAD 4 Andrews' Pitchfork Oscillators v Bollinger Bands

@ AUDUSD "/l Cocte L Volumes , Envelopes

E yole Lines .

& EURGEP B e Bill Williams . Ichimoku Kinke Hyo

% EURAUD - Custom " Moving Average

% EURCHF 1 i i TrErTT )

Symbaols | Tick TRaT | Parabolic 5AR
Navigator . Standard Deviation

7. Trading Operations
Opening a position

Opening the “Order” window can be done in a variety of ways:

"tab of the “Terminal” window and select New order

® By right clicking on the “Market Watch” window or on the “Trade’
from the available menu
® Pressing the F9 button using the Tools -> New order menu sequence
® Right clicking on the chart window and select Trading -> New Order from the context menu
® Double clicking on the currency pair in the “Market Watch” window

MetaTrader 4 “Order” window:

[cariss Symbolt | GEPUSL, Grest Bnhan Pournd v US Podar 10t = 100,000 G5 ~
| i 3451 Voume: 100 -
1350 Stop Lows: 00 [ Tese Profits 0,020 5
| [ " - Crsrsert:
I . ' .II , » Type: :thmmn -:
| ||| I'“u]l“ I'Il | | S tariet Eveasmon
| EA R i 1450
Hf s |4{ MR . 1.31497 / 1.31506
i ! [ W 1 i
I |
| Wy |’|, ]l | rl" | u |—m I Sl by Mkt 1 Burp by Marsat |
| | ll Vi | 138 Close #1365 el 100 GIUSE by Market ]
I-|‘|n' J |l ‘lll ’ 1u4mn Etmntion! The trade vll be executed at market comdrmons, ciffenence with
requestsd prce may be sgrificant!
LJu48E
[ L—-—

9 | Cetnral Clearing LTD



FXCC MetaTrader 4 User Guide

A BROKER ON YOUR SIDE

MetaTrader 4 supports two methods of opening trades: “Market Execution” and “Pending Order”.

Details of your trades can be changed via the available menus in the Order window.

Symbol - currency pair you wish to trade

Volume - number of lots you wish to trade

Stop Loss - where you wish your stop loss to trigger
Take Profit - where you wish your take profit to trigger

Comment - notes you can enter to identify particular trades

The new position will now be listed in the “Trade” tab of the “Terminal” window.

Closing a position

To close a position, highlight the trade in the “Trade” tab of the “Terminal” window and right click to bring up the applicable
menu options.

From here select Close Order. Double clicking on the open position in the “Trade” tab of the “Terminal” window has the same
result.

The “Order #” window appears and clicking the Yellow button closes the trade at the price displayed on the button as shown
in the image below.

Market Watch: 15:38:01 = |PRa

EU = 3 4798
Symbaol Bid Ask ~ |NESIEN BUY
& USDCHF 0.992809 009298 |= 1 5
. ] e o .92 .92
'; New Dlde‘! 9 & EURUSD 114921 114825
_E’cm:) & USDIPY 113235 113239
It & USDCAD 1.29712 1.26721
_.3 Modify or Delete Ordes & AUDUSD 0.70894 0.70900
¥ EURGBP 0.87391 0BT -
Trailing Stop » Symbels | Tick Chart
Profit k aigakor % EL  MNew Order
FXCC - MetaTrader 4 - EL  Close Order
gy
|-y Accounts = B ;
w  Commissions | & @ FXccl-Demo E |54 Modify or Delete Crder
Taxes & 660577 Trailing Stop
- ¥ Indicators
! [P Trend Profit
Comments | & ren
i @~ Oscillators Commissions
¥ Auto Arange A L *r Valumes oo
- Bill Williarns -
Gr o [« t
L d G Commaon | Favorites | |-| EURLSD. He r omments
v Auto Arange
Order -+ Time Type Size Symbo ., Grid
T T 2
L3 13694420 20181010 15:37:40 sell 100 gbpusd 131450 0.00000 000000
| Balance: 4 600.00 EUR Equity: 4 585.21 Margin: 1 072.11 Free margin: 3 513.10 Margin levek 427.68%
B 3 ||® & f D ¥ | BuhewOnde & GautoTadng iy (0 = | & S B (|2 k|G- O B
"4 New Order Fa X | #E5 oA e :
varket Wabch: 15:39:45
=& Close Drder ik
& LEDCHF
- lodiy or Delete Dige T I T
- & FLURLSD
& LEOEY
Trailing Stop 3 % LSDCAD 125706 i H : Symbel: GEPUSL, Grese Enhan Fourd b U Gl 1Lot = 10,000 G =
& AUDUSD 070824 4 (|1 \ 136537 vokme: Lo .
Profit ¥ PETEER S— L i M f— oo Lowsi [ e Profit o0 [
Symbals [ Took Chert . o
e [ e ! )
¥ Commissions FACC - MetaTrader 4 o Tepe:  parket Evecutien =
4 A Accoumns | | | " " WEE™  rparoet vmmon
Toiss - B Freci-Deme “] | e
& sasm b S
. ‘ \ | - 1.31497 / 1.31506
Comments | Trend l ! |
@ F Oscilators ,I l|. ||' [ ' J —IIIW Sl by Markst. ] B by Markat |
| Vol
Auto Arrange A - 3:‘-].:::-” J s3sd8 Choze # 13644421 ped 1,00 GEPLED by Market |
- K ‘|
Giid G Comman | Favorses | ..\,... ||n r - Atzenton! The race vl e svecubed at market conémone, cffenence wih
: 1 Fequestes price may e sgrficant!
Order Time Type 1andEE
P e — e ————

3| Balance: 4 567.81 EUR Equity: 4 55811 Margie: 572.02 Free margin: 3 887,09 Margin levek: 797.01%
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Place/Modify/Delete Stop Loss & Take Profit Orders

Stop Loss - closes an open position at a pre-defined level, in order to minimize trade losses if the market moves against your
trade.

Take Profit - closes an open position at a pre-defined level in order to take profit when the market moves in the direction of
your trades.

Using Stop Loss and Take Profit orders serves as an extra level of risk and money management. Once the markets reach your
pre-defined levels of loss or profit, open positions are closed automatically.

Money management plays a significant role in trading success and the prudent use of Stop and Profit orders plays
fundamental part in managing both risk and profit within MetaTrader 4.

Modifying Stop Loss and Take Profit order can be done via the Trade tab.

Right clicking on the open position or on the pending order in the “Trade” tab of the “Terminal” window and selecting Modify
or delete order brings up the Modify Order dialog.

In the Modify Order dialog, the Symbol and Volume settings cannot be changed. The order Type, defaults to Modify Order.

Setting the desired Stop Loss and Take Profit levels from the drop-downs, applies these levels to the opening price of your
trade. The Copy As buttons display the price your Stop Loss and Take Profit levels will be set as. Clicking the Copy As button
for either order, sets the Stop Loss or Take Profit levels and depending on which type of order you are setting, copies the price
to the Modify button.

Pressing the Modify button, modifies your order.

MetaTrader 4 can also place Trailing Stop orders. These are used to adjust your Stop Loss and Take Profit orders as the
market fluctuates.

This type of order can be used to protect and maximize profits and also minimize potential losses on your trades.

In order to place a trailing stop, highlight the open position in the “Trade” tab of the “Terminal” window and right click to
open context menu.

I Mew Drder F9
|4 Close Order
=4 Modity or Delete Order
| Trailing Stop » Delete Al
Profit b ¥ None
v  Commissions 15 points
Taxes 20 points
Comments 25 points
v Auto Arrange A 30 paints
v Grd G 35 points
M 40 points
45 points
50 points
Custom...
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8. Pending Orders

A Pending Order is use to open a position when prices reach a pre-defined level.

There are four types of pending orders:

W& 650577 FACC1-Dema - Demo Acco

= File  Wew [reedt Chars Tools  Wiedew  Help
- G (|R 2 |Gy (D) i New Order 5 AutoTracir
) ; r |1 L | = & el
k- — A # oA T B-|lh HEoWMmoAm oM |m
Market Watdh: LiSL47 =
Syrrinl Bid sk~ |
USKI IF D50296 | g 1
1.14 g'lq'

194" |

& ELRLISD 114841 11254,
< USDIY 112224 11323
& USDCAD 179657 1705 ([ooeaso Symbol: | GEFUSD, Great Eritian Found s LS Dolar Lok = 100,000 GEF
& AUDLSD 1.70az1 0z i L31s: dokawa: | 1007
R 57353 T4 1o |
L BLET LCTE=E L5 ) A] 3T Stop Lnas 0.00003 Take Prafit: 000000 |
Symbak | Tick Chart | L I |I
A | f il Comment
Faigata” i | 1] LEm
5 FHCC - MutaTracer & ! Type:  Madity Odar -
. 1 LD
A ——
=-[§ FECO-Deme i ‘|' Y|k 1
- basn Feat |'I A Irl.l i i LasT level: 1 = peils el L v poiin
=-[F] Indicators V' f 1 r II | | 131513 o T iase || 131517
4T Trend P 5 Jl,—m bl Copy s SN
-l Desilatars 134508 Stoploss: 00000 [ Tebce Poufil: 000000 |
i -lF] Velumes | ““l“lrll
V@ -E il wilkams ’N I1||Ir"ﬂ lIl L Moy #1365950] el 1,00 GEPUSD #: 0,00000 0 0000
Common | Favsites | Lllll N | e Stop Loss or Take Prafit you 525 must difer from market orice by at l=ast 1 pcints.
= | Geder Time Iype PR ]

[+] m-masn.mun Equity: 4 548,67 Margie: 57202 Fr\oer-lFSM Margin bevel: T05.19%

181010 15:35%31

Buy Stop - an order to open a Buy position at a price higher than the current price level
Sell Stop - an order to open a Sell position at a price lower than the current price level
Buy Limit - an order to open a Buy position at a lower price than the current price level

Sell Limit - an order to open a Sell position at a price higher than the current price level

B 6605TT: FCCL-Demo - Dema Acoount - [EURLISDUHE]

- - n -
=)
B~ E- & & w0 B aNza Order & 9 AvcTreding {10 |18 = Bl 1 ;-i -3- 8-
Uk 4| 1 — # # = A W %-|im 05 MIE B0 HL W DLW M
Harket Watch; 15:45%03 Bl [ =5 T, AR L [T T T T
& USDCHF 099289 4 B I
]
4 GEPLISD 43502 1.14 92 1_1.492 its o TR |
& EURUSD 14524 hl
& USDUPY 13232 11223 i
& UsDCAD 2D 157 CERULD Symbu's | GBPUSD, Great Srdan Pounc vs US Dollar 1Lat = 100,000 GF =
& ALOUSTH OENZ n.mad | L Woume: 100 -
RiTEF T3 il i
LI e LEE L - Stop Lass: £.00000 -5 Take Frodt: 000003 |
Spmibols | Tick Chart |
I _J II' i Comment:
Hawigator s | y L3N
T EECE - MetaTrader 4 bk |4 m v [Pending Crder -
= i, Account 3 ! | ) L
8 accounts t L | V1 Pording Crék
e- [ FACc-Dema i e [N PTErN .
1 g s 7 N rim Lm0
=+ ] Iredicators X | LIS FO [ o '- P
-[#] Trend J |'\J poce; | Sed Li | Ame
- [ S Bu Sto
-1 #| Occillators H“r [ w — 52 ?_:Ibﬁ_ R
- [#] Volumes " A Wi T L 3
- CF] Bl Willierns i 1 T
Cammon [DFESEs -_I | cautat Omen price pou set must differ fon mankes price by at keast £ points.
" Orser Tireie: e L3

A Balance; 4 56781 FUR Equity; 4 556.50 Margin: 572.02 Free mangin:
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Pending Orders can be placed in a variety of methods:

Right clicking on the “Market Watch” window or on the “Trade” tab of the “Terminal” window and selecting New order
Pressing F9 button

Using the Tools -> New order dialog

Right clicking on the chart window and selecting Trading -> New order from the dialog

Double clicking on the currency pair in the “Market Watch” window

Pending orders can then be placed by selecting Pending Order from the menu items.

The following options may be changed in this window as well:

Symbol - currency pairs

Volume - transaction size in lots

Stop Loss - Stop Loss order level

Take Profit - Take Profit order level

Comment - any comments for the particular order

Type - the type of pending order: Buy Stop, Buy Limit, Sell Stop, Sell Limit

At price - pending order level

Expiry - this allows an expiry date to be set. If this option is selected, the order is valid until the particular date selected

Once the order is confirmed (Place button) it appears in your “Trade” tab.

9. Modifying Orders

= Crder #2328393
4 New Order Fa i
= EURGEP Symbol: |EURGEP, Euro vs Great Britan Pound 1 Lot = 100,000 EUR
{8 Close Order
i Volume: | 0.01
L:..j) kdpdity o D e Org Stop Loss: 0.00000 |5 Take Profit: 0.00000 =
h Comment:
Trailing Stop [
Type: [Mcdify Order -
me‘t L3 Modify Order
Price: 0.89862 &
¥ Commissions Stoploss:  0.00000 & Take Profit:  0.00000 &
Expiry: 2016.10.10 14:25 M
Tanes BES ®
odt,
Comments
Open price you set must differ from market price by at least 1 points,
¥ Auto Arange A
¥ Grd G

Modifying or deleting a Pending Order is similar to modifying any other order type.

Right clicking the order in your Trade tab brings up the modify order dialog.

The order can now be modified or deleted by using the Modify or Delete buttons in the dialog.

For further assistance regarding the MetaTrader 4 User Guide, please feel free to contact us:

Phone: +44 203 150 0832 | Email: support@fxcc.net
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